
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 6x 

 

 
 
 
 
 

User Reference Manual 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Produced by Information Technology Services 
Last Update: February 2004 



Internet-Native Banner 6x User Reference Manual  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This page intentionally left blank. 

2 



 Internet-Native Banner 6x User Reference Manual 

Table of Contents 
 

How to Use this Manual ..................................................................................... 5 
Bookmarks ........................................................................................................................ 5 
Hyperlinks ......................................................................................................................... 5 
Text Find............................................................................................................................ 5 
Display Settings................................................................................................................ 5 

Getting Started ................................................................................................... 6 
System Requirements...................................................................................................... 6 
Internet-Native Banner Setup .......................................................................................... 6 
Login and Password Change .......................................................................................... 6 

Navigating through Banner ............................................................................... 7 
Shortcut Keystroke Chart ................................................................................................ 8 
Exiting................................................................................................................................ 8 
Naming Conventions........................................................................................................ 8 

Part of a Form................................................................................................... 10 

Customizing Banner ........................................................................................ 12 
Customized Toolbars ..................................................................................................... 12 
Bubble Help..................................................................................................................... 12 
Title Bar Display Options............................................................................................... 12 
Displayed Form Names.................................................................................................. 13 
Personal Menu ................................................................................................................ 13 

General Person................................................................................................. 14 
ID/Name Search .............................................................................................................. 14 
Identification Information .............................................................................................. 14 

General Student ............................................................................................... 15 
General Student Information ......................................................................................... 15 
Student Attributes .......................................................................................................... 15 
Advisor Assignments..................................................................................................... 16 
Student Queries .............................................................................................................. 17 
Student Reports.............................................................................................................. 17 

Registration ...................................................................................................... 18 
Student Schedule/Registration Information ................................................................ 18 
Add/Drop Activity ........................................................................................................... 18 
Course Rosters ............................................................................................................... 19 
Registration Reports ...................................................................................................... 19 

Catalog/Schedule ............................................................................................. 20 
Course Section Queries................................................................................................. 20 
Basic Course Information.............................................................................................. 20 
Course Schedule and Enrollment Queries .................................................................. 20 
Enrollment Reports ........................................................................................................ 21 

Faculty............................................................................................................... 22 
Faculty/Advisor Queries ................................................................................................ 22 
Faculty Schedule ............................................................................................................ 22 

Academic History............................................................................................. 23 
Institutional Course Summary ...................................................................................... 23 
Courses/GPA by Term ................................................................................................... 23 

 3 



Internet-Native Banner 6x User Reference Manual  

Courses/GPA by Subject ............................................................................................... 24 
Degree Information......................................................................................................... 24 
Academic History Reports............................................................................................. 24 

Querying Form Data .........................................................................................25 
Using Wild Cards ............................................................................................................ 25 
Using Comparison Operators ....................................................................................... 26 
Counting Records .......................................................................................................... 26 

Banner Reports .................................................................................................27 
Course Information ........................................................................................................ 27 
Student Information ....................................................................................................... 27 
Transcript Analysis ........................................................................................................ 27 
Admission Information .................................................................................................. 28 
Graduation Information.................................................................................................. 28 

Student Information Services (SIS) .................................................................29 
SIS for Faculty ................................................................................................................ 29 
SIS for Students.............................................................................................................. 29 

Help ....................................................................................................................30 

Appendix A........................................................................................................31 

Glossary ............................................................................................................38 
 

4 



 Internet-Native Banner 6x User Reference Manual 

How to Use this Manual 
 
This User Reference Manual is designed for online use in Adobe Acrobat software.  You may print a copy 
if you choose; however, the online format is the most current version and is searchable.  When opening 
the online Manual, this page should automatically display in the right pane and a list of bookmarks should 
display in the left pane. 
 

Bookmarks 
 
Use the bookmarks in the left pane to jump to other sections of the Manual, which will be 
displayed in the right pane. 
 
Use the scroll bar on the right to browse through the Manual page by page.  As you browse 
through different sections, you’ll notice that the bookmark for the current section is bolded in the 
left pane. 
 

Hyperlinks 
 
Throughout the Manual, you will notice blue, hyperlink text.  Click on this text to follow the link, 
causing that information to appear in the right pane.  Hyperlinks may jump to other places within 
the Manual or open related websites.  If the linked information is visible on the same page as the 
hyperlink text, you may not notice any change when clicking it.  A website link will cause the 
webpage to open in your browser window (it will not be displayed in the Acrobat Reader window). 
 

Text Find 
 
You can look for occurrences of key words in the Manual using the Find feature.  The Find 
feature in Acrobat Reader is the same tool used in Microsoft applications to quickly locate the 
specified text. 
1. Click the         [Find] icon in the Acrobat toolbar. The Find window will open. 
2. Enter the text you're looking for. 
3. Click the Find button.  The first occurrence of the text will be highlighted in the right pane. 
4. Click the Find icon again to reopen the Find window. 
5. Click the Find Again button to locate the next occurrence, or enter new text to begin a 

different search. 
 

Display Settings 
 
You can adjust the size of the page display in the right pane using the View icons in the Acrobat 
Reader toolbar. 

•        [Actual Size] – display size is comparable to its printed format. 
•        [Fit in Window] – display size allows an entire page to be in view. 
•        [Fit Width] – display size shows the full width of the page, but requires scrolling to 

view length of page. 
Note: You may also use the        [Zoom] icon on the toolbar to further magnify the view, then 
use the View icons to return the view to normal size. 
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Getting Started 
 

System Requirements 
Banner is currently accessible only from an on-campus, networked computer.  Remote users 
should use the web-based Student Information Services (SIS) system to access limited 
information from the Banner system. 
 
The following specifications are necessary to run Internet Native Banner (Internet Native Banner, 
referred to as INB, is web-based, meaning users can access Banner using a web browser such 
as Internet Explorer or Mozilla): 
 

Supported Browsers: 
Windows:  IE 5x & 6x, Netscape 6x 
Mac:  OS 8.5 – IE 4x 
Mac:  OS X – IE 5x or Mozilla 1.4 

 

Internet-Native Banner Setup 
Please refer to Quicknote 30 for instructions with setting up and logging into Internet-Native 
Banner 5.x on a Windows machine.  Macintosh computers require no setup. 
 

Login and Password Change 
Please refer to Quicknote 31 for instructions on logging into Banner and changing your Banner 
password. 
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Navigating through Banner 
Banner provides several ways to navigate through the system: 

• Main Menu 
• Direct Access  
• Object Search  
• Site map 
• Options menu 

 
After logging in, the Banner main menu screen will appear.   

 
 
Main Menu 
You can use the main menu to select from a list of the menus, forms, and jobs in Banner. The 
main menu shows the various levels of menus. These levels are nested within a hierarchical tree 
structure. You can easily navigate through Banner by expanding and collapsing these menus. 
Once you have “drilled down” to the item you want, you can click its link to access it. 
 
To expand or collapse a menu: 
Select the plus sign (+) to the left of a menu to expand the menu so you can see the objects it 
contains. Select the minus sign (-) to collapse it. 
 
To access a menu item: 
1. Expand the menu you want to start with by selecting the plus sign (+) to the left of a menu. 
2. Continue expanding menus until you drill down to the form, or job you want. 
3. Click the name of the form, or job you want to access. 
 
Direct Access 
You can use direct access to access a menu, form, or job by its name. You can use direct access 
from the main menu or from a form. 
 
To use Direct Access from the main menu: 
1. Enter the name of the menu, form, or job in the Go field. 
2. Press Enter. 
 
To use Direct Access from a form: 
Note: When you use direct access from a form, the current form remains open. When you exit 
the requested form, or job, you return to the original form. 
1. Select File>Direct Access. The Direct Access Form (GUAPARM) appears. 
2. Enter the name of the form, or job in the Enter a valid name field. (Note: You cannot use 
direct access to access a menu from a form.) 
3. Click the Start button or press Enter. 
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Object Search 
You can use Object Search to access a form, or job if you know part of its name, description, or 
type.  Note: When you use Object Search from a form, the current form remains open. When you 
exit the requested object, you return to the original form. 
 
To use Object Search: 
1. Double-click the Go field or click the search icon on the main menu. 
OR 
Select File>Object Search from any form. 
2. Enter your search criteria on the Object Search Form (GUIOBJS). 
You can use any or all of the Name, Description, and Type fields. You can use the wildcards %. 
3. Select the Execute Query function. A list of all matches appears. 
4. Scroll to the desired name. 
5. Double-click the desired name or click the Start button. 
 
Site Map 
The site map appears on a separate page accessible by selecting the Site Map icon. It lists the 
top-level menus in your installation, and one level below them. There are no fields on it, only links 
to the various menus and forms. 
 
If you select a menu from the site map, the Main menu appears, displaying the menu you 
selected with one level expanded. If you select a form, a process, or a job, it will be displayed. 
 
Options Menu 
You can use the Options menu in the menu to navigate within Banner. Options in the menu 
depend on where the cursor is currently located. Some options take you to other blocks and 
windows within the current form. Other options take you outside the current form to other related 
forms. 
The Options menu optionally displays the form name associated with each option that takes you 
outside the current form. You can set up this option on the General User Preferences 
Maintenance Form (GUAUPRF).  
 

Shortcut Keystroke Chart 
For information on using key strokes as an alternative to mouse navigation, please refer to 
Quicknote 32. 
 

Exiting 
To exit a form and return to the menu, click the        [Exit] icon in the upper, right corner of the 
toolbar.  Clicking the Exit icon when the menu is in view will prompt you to exit Banner. 
 

Naming Conventions 
Banner forms, reports, jobs, and tables have seven-character names that follow a defined 
structure as shown on the next page.   
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Position 1 
Identifies the primary 
system owning the form, 
report, job, or table 

Position 2 
Identifies the module owning 
the form, report, job, or table. 

Position 3 
Identifies the type of form, 
report, job, or table. 

Positions 4, 5, 6, and 7 
Uniquely identify the 
form, report, job, or 
table. 

G General E Event Management 
J Job Submission 
L Letter Generation 
O Overall 
P Purge 
S Security 
T Validation form/table 
U Utility 
X Cross product 

A Application form 
B Base table or batch 

COBOL process 
I Inquiry form 
O Online COBOL process 
Q Query form 
R Rule table, repeating 

table, or report/process 
T General maintenance or 

temporary table 
V Validation form/table 

See examples below. 

R Financial Aid B Budgeting 
C Record Creation 
E Electronic Data Exchange 
F Funds Management 
H History and Transcripts 
J Student Employment 
L Logging 
N Need Analysis 
O Common Functions 
P Packaging & 

Disbursements 
R Requirements Tracking 
S Student System Shared 

Data 
T Validation/rule table 
U Utility 

A Application form 
B Base table 
I Inquiry form 
P Process/report 
R Rule table, repeating 

rules table or Report 
T Temporary table 
V Validation form/table 

See examples below. 

S Student A Admissions 
C Catalog 
E Support Services 
F Registration/Fee 

Assessment 
G General Student 
H Grades/Academic History 
I Faculty Load 
L Location Management 
M CAPP 
O Overall 
P Person 
R Recruiting 
S Schedule 
T Validation form/table 
U Utility 

A Application form 
B Base table 
I Inquiry form 
P Process 
Q Query form 
R Rule table or repeating 

table or report/process 
V Validation form/table 
 

See examples below. 

T Accounts Receivable F Finance Accounts 
Receivable 

G General Accounts 
O Overall 
R Research Accounting 
S Student Accounts 

Receivable 
T Validation form/table 
U Utility 
V Authorizations 

A Application form 
I Inquiry form 
P Process 
Q Query form 
R Report 
V Validation form/table 
 

See examples below. 

 
Examples from the Student System are given below. 
 
SPAIDEN SFRSLST STVTERM 
S Student S Student S Student 
P Person F Registration T Validation form/table 
A Application R Report V Validation form/table 
IDEN Identification SLST Class Roster TERM Term Code 
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Part of a Form  
 
Below is a Banner form with each part labeled.  A description of each part is on the following 
page of this manual. 
 

 
 
 
 

Below is the Toolbar with each icon labeled.   
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Menu Bar The Banner menu bar, located at the top of every form, contains pull-down 
menus. 

Toolbar Toolbar contain icon buttons that perform common functions. The toolbar 
appears directly under the menu bar. When you move your cursor to an iconic 
button and pause, a bubble appears with text that describes the function of the 
button.  A detailed picture of the toolbar is on the previous page of this manual. 

Title Bar 
 

The title bar shows the following information: 
• Descriptive form name 
• Form name (seven or eight characters) 
• Release number 
• Database name (PROD) 

Key Block 
 

The key block is the first block on most forms and contains key information that 
determines what is entered or displayed on the rest of the form. All information 
on the form refers to the key block. 
 
The key block has at least one field and sometimes more. For example, a form 
that maintains general student information may have key block fields for both the 
student’s ID and the term. 
 
When the cursor is in the key block, enterable fields in the key block are 
enabled. When you leave the key block, enterable fields in the key block are 
disabled.  

Other Blocks Other blocks contain additional details for the key information. Each block 
contains related information and is usually enclosed in a beveled box 

Auto Hint The auto hint at the bottom of the form can contain the following information for 
the field where the cursor is located: 
• Brief field description 
• Error and processing messages 
• Keyboard equivalents, if you can access other blocks, windows, or forms from 
the field 

Status Line The status line directly under the auto hint can contain one or more of the 
following messages: 
• Record n/n Shows the number of the current record followed by the total 

number of records in the current block. If there are more records than fit in 
the window, the total appears as a question mark (for example, 3/?) until you 
scroll to the last record in the block. Once the last record is displayed, the 
total appears as a number (for example, 3/15). 

• List of Values Indicates the field has a List of Values.   
• Enter Query Indicates the form is in query mode.  

Options Menu 
 

This pull-down menu contains navigation options. Navigation options vary from 
form to form and depend on where the cursor is currently located. Some options 
take you to other blocks and windows within the current form. Other options take 
you outside the current form to related forms.  
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Customizing Banner  
 
You can customize Banner to meet your individual needs.  For example you can: 

• Customize toolbars. 
• Display or hide bubble help. 
• Choose what information appears in title bars. 
• Specify whether form names appear on menus. 
• Create a personalized menu in My Banner 

 

Customized Toolbars 
 
To display or hide the horizontal toolbar: 
1. Using direct access, enter the form name, GUAUPRF, into the Go field and press <Enter>. 
2. Under the Toolbar Display Options, click to select or clear the Display Horizontal Toolbar 

checkbox, depending on whether you want to display the toolbar. 
3. Click the OK button. A dialog box says you must exit and restart Banner to see the changes. 
4. Click the OK button in the dialog box. 
5. Exit Banner. 
6. Restart Banner to see your changes. 
 

Bubble Help 
 
To display or hide bubble help: 
1. Using direct access, enter the form name, GUAUPRF, into the Go field and press <Enter>. 
2. Under the Toolbar Display Options, click to select or clear the Display Bubble Help checkbox, 

depending on whether you want to display bubble help. 
3. Click the OK button. A dialog box says you must exit and restart Banner to see the changes. 
4. Click the OK button in the dialog box. 
5. Exit Banner. 
6. Restart Banner to see your changes. 
 

Title Bar Display Options 
 
The General User Preferences Maintenance Form (GUAUPRF) is used to select information to 
be displayed in your title bars. 
1. Using direct access, enter the form name, GUAUPRF, into the Go field and press <Enter>. 
2. Under the Form Display Options, click to select or clear the display options, depending on the 

information you want to see on your form title bars. 
• Form names 
• Release numbers 
• Database instances 

3. Select the OK button. A dialog box says you must exit and restart Banner to see the changes. 
4. Select the OK button in the dialog box. 
5. Exit Banner. 
6. Restart Banner to see your changes. 
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Displayed Form Names 
 
You can choose to display or hide form names in the Options menu by adjusting settings 
on the General User Preferences Maintenance Form (GUAUPRF).   
1. Using direct access, enter the form name, GUAUPRF, into the Go field and press 

<Enter>. 
2. Under the Form Display Options select the form name display option from the pull-

down list. 
3. Click the OK button. A dialog box says the change has been applied. 
4. Click the OK button in the dialog box. 
Note: A change to this display option occurs immediately. You do not need to exit 
Banner. However, if you change any other display options, you must exit and restart 
Banner to see the changes. 
 

Personal Menu 
 
You can create your own personal menu containing specific forms and/or menus you 
most frequently use.  This menu will display as My Banner at the top of the main menu.  
Please refer to Quicknote 34 for instructions on creating and modifying your personal 
menu (My Banner). 
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 General Person 
ID/Name Search 
Banner forms require a valid ID number.  Refer to Quicknote 33 for assistance in locating names 
and IDs. 
 

Identification Information 
Identification information consists of current and previous ID number, name, address, and phone 
number and is found on the Identification Form (SPAIDEN). 
1. Using direct access, enter the form name, SPAIDEN, into the Go field and press <Enter>.  
2. Enter a known social security number or alternate University ID number, or search by name. 
3. Press <Ctrl> + <Page Down> to pull the student's information into the form. 
4. To view previous ID and/or name information, go to the Options Menu, then select Alternate 

Names/IDs. 
5. To view address and phone information, go to the Options Menu, then select Addresses. 

Note: Multiple addresses and phone numbers may exist for a single person.  The A1 type 
address is considered the primary address for a student.  Addresses appear in date order, 
with the most recent first.  Use the scroll bar to see previous addresses and/or other types of 
current addresses, or enter a query to locate a specific address.  

6. To the main page of the Identification Form go to the Options Menu, then select Current 
Name/ID. 
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General Student 
General Student Information 
General student information, such as college, major, class standing, etc., is best viewed online 
using the General Student Form (SGASTDN). 
Note: A new record is created each time a key piece of information, such as major or class 
standing, changes. Thus, a student may have multiple student records.   
Note: Use SGASTDQ to simultaneously view all term records and/or to query specific records. 
1. Using direct access, enter the form name, SGASTDN, into the Go field and press <Enter>. 
2. Enter a known social security number or alternate University ID, or search by name. 
3. (Optional) To view the current term record, press <Tab> to place your cursor in the Term 

field, and enter the current 6-digit term code (e.g. 200210) or text description (e.g. Fall 2001), 
or double-click in the Term field to select from a list of term codes.  Leave the Term field 
blank to view all term records, with the highest term appearing first. 

4. Press <Ctrl> + <Page Down> to pull the student's information into the form. 
5. Use the scroll bar to view information for previous terms. 
6. Major(s) can be seen by clicking the Primary icon.  Click Return to return to the main page of 

the General Student Form.  Similarly, if the Secondary icon shows lines like a notepad, then 
additional majors and minors exist under Secondary curriculum. 

7. Other information may be viewed by clicking the appropriate selections from the Options 
menu, including: 

 Academic Status Student Cohorts and Attributes
 Graduation Status High School Information 
 Assign Advisors Prior College Information 
  View Student’s Schedule

Note: Some of the above options will load a new Banner form (check the form name in the 
title bar).  To close a sub-window of SGASTDN, click the return button in the lower right 
corner of the window.  To close a new form and return to SGASTDN, click Exit. 

 

Student Attributes 
The Additional Student Information Form (SGASADD) shows student attributes, such as Honors 
Program, and assigned cohort groups. 
1. Using direct access, enter the form name, SGASADD, into the Go field and press <Enter>. 
2. Enter a known social security number or alternate University ID, or search by name.   
3. Press <Tab> and enter the desired 6-digit term code (e.g. 200210) or text description (e.g. 

Fall 2001) in the Term field, or double-click in the Term field to select from a list of term 
codes. 

4. Press <Ctrl> + <Page Down> to pull the student's information into the form. 
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Advisor Assignments 
Advisor assignments may be viewed and updated on the Multiple Advisors Form (SGAADVR). 
Note: In order for an instructor to view a student’s transcript in SIS, the student must either be 
enrolled in one of the instructor’s courses or be assigned as an advisee on SGAADVR. 
 
To view advisor information: 
1. Using direct access, enter the form name, SGAADVR, into the Go field and press <Enter>. 
2. Enter a known social security number or alternate University ID, or search by name. 
3. Press <Tab> and enter the desired 6-digit term code (e.g. 200210) or text description (e.g. 

Fall 2001) in the Term field, or double-click in the Term field to select from a list of term 
codes. 

4. Press <Ctrl> + <Page Down> to pull the student's information into the form. 
 
To change an advisor, follow the steps to view advisor information, and then proceed as follows. 
1. Click the Maintenance icon. 
2. Select End Advisor. 
3. From the Record menu, select Duplicate to begin a new term record. 
4. From the Record menu, select Remove to remove the previous advisor’s name. 
5. Enter the new advisor’s social security number or alternate University ID, or search by name. 

Note: A name search may be performed here using the same process as searching from the 
name field in the key block.  Generic, department advisors have an ID beginning with ‘ADV%’ 
and a first name of ‘Advisor’. 
Note: Clicking the ID Search icon will activate the Faculty/Advisor Query Form (SIAIQRY).  
See section entitled “Faculty/Advisor Queries” for assistance with this form. 

6. Enter the appropriate advisor code, or double-click in the Code field to select from a list of 
advisor codes. 

7. Click to place a checkmark in the Primary box, designating this individual as the primary 
advisor. 

8. Click Save.  The Auto Hint line should indicate “Transaction complete.” 
Note: The Auto Hint line may display an error message indicating that this person is not an 
advisor for this term.  Contact the Registrar’s Office to activate advisor status for a faculty or 
staff member. 

 
To add a secondary advisor, follow the steps to view advisor information, and then proceed as 
follows. 
1. In the first blank row below the current advisor, enter the additional advisor’s social security 

number or alternate University ID, or search by name. 
Note: A name search may be performed here using the same process as searching from the 
name field in the key block.  Generic, department advisors have an ID beginning with ‘ADV%’ 
and a first name of ‘Advisor’. 
Note: Clicking the ID Search icon will activate the Faculty/Advisor Query Form (SIAIQRY).  
See section entitled “Faculty/Advisor Queries” for assistance with this form. 

2. Enter the appropriate advisor code, or double-click in the Code field to select from a list of 
advisor codes. 

3. Click Save.  The Auto Hint line should indicate “Transaction complete.” 
Note: The Auto Hint line may display an error message indicating that this person is not an 
advisor for this term.  Contact the Registrar’s Office to activate advisor status for a faculty or 
staff member. 
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Student Queries 
Groups of students may be identified by academic standing, level, college and/or major using the 
Academic Standing Query Form (SHASTAT). 
Note: SHASTAT displays information for graded terms only. 
1. Using direct access, enter the form name, SHASTAT, into the Go field and press <Enter>. 
2. Enter a 6-digit term code (e.g. 200210) or text description (e.g. Fall 2001) in the Term field, or 

double-click in the Term field to select from a list of term codes (you must select a term that 
has already been graded). 

3. Press <Ctrl> + <Page Down> to move your cursor to the query block. 
4. Press <F7> to enter a query, and type the desired criteria into the appropriate field(s).  

Queries may be performed in the standing, level, college or major fields, or any combination 
of those fields. 
Note: For a list of valid codes, double-click your mouse in a field with a blue title to see a list 
of values, or click the flashlight icon when provided. 

5. To simply retrieve a count of the records meeting the specified criteria, press <Shift> + <F2> 
to count query hits, or select Count Hits from the Query menu on the menu bar.  The record 
count will be displayed in the gray Auto Hint bar at the bottom of the screen. 

6. To execute the query and retrieve the selected records, press <F8> or click the Execute 
Query icon on the toolbar. 

Note: See section entitled “Querying Form Data” for further assistance with performing queries. 
 

Student Reports 
Student information is available in printable reports and downloadable files.  Please see section 
entitled “Banner Reports” for further information. 
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Registration 
Student Schedule/Registration Information 
A student's registration information (schedule) is best viewed online using the Registration Query 
Form (SFAREGQ). 
Note: SFAREGQ will show Registered and Waitlisted courses only.  Dropped courses must be 
viewed using SFASTCA. 
1. Using direct access, enter the form name, SFAREGQ, into the Go field and press <Enter>. 
2. Enter a 6-digit term code (e.g. 200210) or text description (e.g. Fall 2001) in the term field, or 

double-click in the Term field to select from a list of term codes.  (optional) You may enter 
from and to dates in the date range fields instead of term. 

3. Press <Tab> to move to the ID field.  Enter a known social security number or alternate 
University ID, or search by name. 

4. Press <Ctrl> + <Page Down> to pull the student's registration information into the form.  Use 
the scroll bars to view additional information. 
Note: If the student’s schedule does not appear, check the Auto Hint line at the bottom of the 
window for a message indicating the student has no registration for the term entered. 

Note: SFAREGQ may also be used to query specific registration information, such as all ENG 
courses, or all courses that meet on Monday.  See section entitled “Querying Form Data” for 
assistance with performing queries. 
 

Add/Drop Activity 
Detailed registration information, including all add/drop activity, can be viewed online using the 
Student Course Registration Audit Form (SFASTCA). 
Note: SFASTCA will show all registration activity, including errors and corrections made by the 
student or registration personnel.  It is best used to query specific types of activity or specific 
courses. 
1. Using direct access, enter the form name, SFASTCA, into the Go field and press <Enter>. 
2. Enter the 6-digit term code (e.g. 200210) or text description (e.g. Fall 2001) in the Term field, 

or double-click in the Term field to select from a list of term codes.  (optional) You may enter 
from and to dates in the date range fields instead of term. 

3. Press <Tab> to move to the ID field.  Enter a known social security number or alternate 
University ID, or search by name.   

4. Press <Ctrl> + <Page Down> to pull the student's registration detail into the form.  Use the 
scroll bars to view additional information. 

5. To enter a query, press <F7>.  You may query any of the fields by typing the desired value in 
the appropriate field. 
• Ex. 1:  To query all dropped courses, place your cursor in the Course Status field and 

type "D%". 
• Ex. 2:  To query all activity for a specific course, type the subject and course number in 

the Subject and Course fields. 
6. To execute the query, press <F8>. 
Note: See section entitled “Querying Form Data” for further assistance with performing queries. 
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Course Rosters 
Course rosters may be viewed online using the Class Roster Form (SFASLST). 
1. Using direct access, enter the form name, SFASLST, into the Go field and press <Enter>. 
2. Enter the current 6-digit term code (e.g. 200210) or text description (e.g. Fall 2001) in the 

Term field, or double-click in the Term field to select from a list of term codes. 
3. Press <Tab> and enter a valid Course Reference Number (CRN) or click the flashlight icon to 

look up the number. 
Note: See section entitled “Course Section Queries” for more information on CRNs. 

4. Click on View Summary of Section in the Options menu to see additional course information, 
including credit hours, instructor, enrollment and waitlist count.  Click the Return button to 
close the summary window.   
Note: Summary information is available only from the key block. 

5. Press <Ctrl> + <Page Down> to pull the roster information into the form. 
Note: SFASLST may also be used to query specific roster information, such as waitlisted 
students.  See section entitled “Querying Form Data” for assistance with performing queries. 
 

Registration Reports 
Course rosters and other enrollment data are available in printable reports and downloadable 
files.  Please see section entitled “Banner Reports” for further information. 
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Catalog/Schedule 
Course Section Queries 
Each semester, all active course sections are assigned a Course Reference Number (CRN) that 
uniquely identifies each course.  The Schedule Section Query Form (SSASECQ) is used to look 
up CRNs by subject, course, and section number and to view enrollment data. 
1. SSASECQ is usually accessed by clicking the CRN search icon from another form.  It may 

also be accessed directly from the menu using direct access. 
2. Once in SSASECQ, enter the current 6-digit term code in the Term field, or double-click in the 

Term field to select from a list of term codes. 
3. Enter the course information (subject, course number, and section number) into the 

appropriate fields. 
Note: For a list of valid codes, double-click your mouse in a field with a blue title to see a list 
of values, or click the flashlight icon when provided. 

4. Press <F8> to execute the query. 
5. Use the scroll bar if necessary to view additional records. 
6. If SSASECQ was accessed by clicking the CRN search icon from another form, place your 

cursor in any of the fields for the desired course and double-click your mouse to select it. 
Note: To view detailed information (SSASECT) for a particular course section, place the 
cursor in any of the fields for the desired course and select Count Hits from the Query menu. 

Note: SSASECQ is also used to view enrollment counts and perform many useful enrollment 
queries.  See the section entitled "Course Schedule and Enrollment Queries" for additional 
information on enrollment counts. 
 

Basic Course Information 
The Basic Course Information Form (SCACRSE) shows credit hours, level, grading mode, 
schedule type and similar information found in the course catalog. 
Note: To view similar information for a particular section and term, use the Schedule Form 
(SSASECT). 
1. Using direct access, type the form name, SCACRSE, into the Go field and press <Enter>. 
2. Enter a valid subject code, course number, and term in the appropriate fields in the key block. 

Note: For a list of valid codes, double-click your mouse in a field with a blue title to see a list 
of values, or click the flashlight icon when provided. 

3. Press <Ctrl> + <Page Down> to pull basic course data into the form. 
4. Use the links in the Options menu to view additional information, such as grading modes, 

prerequisites, etc. 
 

Course Schedule and Enrollment Queries 
The Schedule Section Query Form (SSASECQ) is used to identify closed courses, waitlist counts, 
and other enrollment data. 
1. Using direct access, type the form name, SSASECQ, into the Go field and press <Enter>. 
2. Enter the current 6-digit term code in the Term field, or double-click in the Term field to select 

from a list of term codes. 
3. Enter additional search criteria into the appropriate fields.   

Note: For a list of valid codes, double-click your mouse in a field with a blue title to see a list 
of values, or click the flashlight icon when provided. 
• Ex. 1:  To identify all sections of a course, enter a subject and course number only. 
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• Ex. 2:  To identify courses with spaces available, enter ">0" (without quotes) in the 
Available Enrollment field, third from the left on the Enrollment line. 

• Ex. 3:  To identify waitlisted courses, enter ">0" (without quotes) in the Actual Waitlist 
Enrollment field. 

4. Press <F8> to execute the query. 
5. Use the scroll bar if necessary to view additional records. 
6. To enter a new query, press <F7>, then repeat steps 2 through 4. 
 
SSASECQ displays the following information. 

 
 
A Term 6-digit term code (ex: 200020) 
B P/T Part-of-Term currently used for Main and NetPlus!  
C Reg From First Date Registration is Allowed (not currently used at UM-Flint) 
D Reg To Last Date Registration is Allowed (not currently used at UM-Flint) 
E CRN Course Reference Number uniquely identifies each section 
F Bl Block Code Indicator not currently used at UM-Flint 
G Subj Subject Code three upper-case letters (ex: ENG) 
H Crse Course Number (ex: 111) 
I Sec Section Number must be two digits (ex: 02) 
J St Course Status identifies if the course is Active or Cancelled 
K Camp Campus all courses except NetPlus! are designated Main 
L Course/Section Title 
M Schd Schedule Type identifies the course format (Lecture, Lab, etc.) 
N Inst Md Instructional Method Code not currently used at UM-Flint 
O Duration Number of Units to complete course (not currently used at UM-Flint) 
P Duration Unit Unit Code not currently used at UM-Flint 
Q Link Link Identifier not currently used at UM-Flint 
R XList Cross-List Group Number links cross-listed courses 
S Rsvd Reserved Indicator not currently used at UM-Flint 
T Long Long Title Exist Checked if Yes 
U Syllabus Syllabus info Exist Checked if Yes (not currently used) 
V Comments Section Comments Exist Checked if Yes 
W Enroll Max Maximum Enrollment cap at which course will close 
X Enroll Act Actual Enrollment number of students officially registered 
Y Enroll = Available Enrollment spaces available in course 
Z W/L Max Waitlist Maximum maximum number allowed to waitlist 
AA W/L Act Actual Waitlist number of students waitlisted for course 
BB W/L = Available Waitlist  spaces available on waitlist 

 
Note: Enrollment counts on SSASECQ do not reflect combined totals for cross-listed courses.  
Note: See section entitled “Querying Form Data” for further assistance with performing queries. 
 

Enrollment Reports 
Course registration and enrollment information is available in printable reports and downloadable 
files.  Please see section entitled “Banner Reports” for further information. 

 21 



Internet-Native Banner 6x User Reference Manual  

Faculty 
Faculty/Advisor Queries 
The Faculty/Advisor Query Form (SIAIQRY) is used to identify faculty and advisors who are 
active for a specific term.  It can also be used to query faculty and advisors by name, college and 
department. 
1. Using direct access, type the form name, SIAIQRY, into the Go field and press <Enter>. 
2. Enter the current 6-digit term code (e.g. 200210) or text description (e.g. Fall 2001) in the 

Term field, or double-click in the Term field to select from a list of term codes. 
3. Click to place a checkmark in the Faculty box to view faculty only, in the Advisor box to view 

advisors only, or in both boxes to view individuals who are both faculty and advisor for the 
specified term. 

4. Press <Ctrl> + <Page Down> to activate the search block. 
5. Press <F8> to execute a complete search, or enter additional criteria in the search block. 

Note: A name or ID search may be performed using the same process as searching from the 
name and ID fields in a key block. 

 

Faculty Schedule 
The Faculty Schedule Query Form (SIAASGQ) is used to view an instructor's course schedule for 
a specific term. 
1. Using direct access, type the form name, SIAASGQ, into the Go field and press <Enter>. 
2. Enter the current 6-digit term code (e.g. 200210) or text description (e.g. Fall 2001) in the 

Term field, or double-click in the Term field to select from a list of term codes. 
3. Enter a known social security number or alternate University ID number, or search by name. 
4. Press <Ctrl> + <Page Down> to pull the schedule into the form. 
5. Use the scroll bars to view additional information. 
Note: SIAASGQ may also be used to query specific fields.  See section entitled “Querying Form 
Data” for assistance with performing queries. 
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Academic History 
Transcript information (all graded coursework) is found in the Academic History module and can be 
viewed from three different forms, the Course Summary Form (SHACRSE), the Term Sequence Course 
History Form (SHATERM), and the Subject Sequence History Form (SHASUBJ).  Academic History also 
includes information on degrees, both sought and awarded. 
 

Institutional Course Summary 
The Course Summary Form (SHACRSE) shows all institutional coursework (i.e., all courses 
taken at UM-Flint).  Coursework may be viewed for a particular term or for all terms and includes 
courses taken at various student levels (undergraduate, graduate, etc.). 
1. Using direct access, type the form name, SHACRSE, into the Go field and press <Enter>. 
2. Enter a known social security number or alternate University ID number, or search by name. 
3. (Optional) To view courses for a specific term, press <Tab> and enter the current 6-digit term 

code (e.g. 200210) or text description (e.g. Fall 2001) in the Term field, or double-click in the 
Term field to select from a list of term codes.  To view courses for all terms, leave the Term 
field blank. 

4. Press <Ctrl> + <Page Down> to pull the course information into the form. 
5. Use the scroll bar, if necessary, to view additional records. 
6. Click on Course Title in the Options menu to view course titles. 
7. Click the Detail icon to the left of a course to view additional information, such as instructors 

and attributes. 
Note: SHACRSE can also be used to query courses by level, subject and other fields.  See 
section entitled “Querying Form Data” for assistance with performing queries. 
 

Courses/GPA by Term 
The Term Sequence History Form (SHATERM) shows cumulative GPA and credit hours, followed 
by term GPA and course detail (both transfer and institutional), for a specific student level (ex., 
undergraduate). 
Note: Transfer course detail may appear separately from transfer credit totals in the term listings. 
1. Using direct access, type the form name, SHATERM, into the Go field and press <Enter>. 
2. Enter a known social security number or alternate University ID number, or search by name. 
3. Press <Tab> and enter the desired level code, or double-click in the Level field for a list of the 

student’s levels. 
4. (Optional) To view course detail as of a certain semester, press <Tab> and enter the 

appropriate 6-digit term code (e.g. 200210) or text description (e.g. Fall 2001) in the Start 
Term field, or double-click in the Start Term field to select from a list of term codes.  To view 
course detail for all terms, leave the Start Term blank. 

5. Press <Ctrl> + <Page Down> to pull the course information into the form. 
6. Press <Ctrl> + <Page Down> again to see term GPA and course detail.   
7. Use the top right scroll bar to view information for additional terms, and use the bottom right 

scroll bar to view additional courses for a term. 
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Courses/GPA by Subject 
The Subject Sequence History Form (SHASUBJ) shows cumulative GPA and credit hours, 
followed by subject GPA and course detail (both transfer and institutional), for a specific student 
level (ex., undergraduate).   
1. Using direct access, type the form name, SHASUBJ, into the Go field and press <Enter>. 
2. Enter a known social security number or alternate University ID number, or search by name. 
3. Press <Tab> and enter the desired level code, or double-click in the Level field for a list of the 

student’s levels. 
4. (Optional) To view detail for a particular subject, press <Tab> and enter a subject code in the 

Start With Subject field, or double-click in the field for a list of valid subject codes.  To view 
detail for all subjects (sorted alphabetically), leave the Subject field blank. 

5. Press <Ctrl> + <Page Down> to pull course information into the form. 
6. Press <Ctrl> + <Page Down> again to view subject-specific credits, GPA, and course detail. 
7. Use the top right scroll bar to view information for additional subjects, and use the two lower 

scroll bars to view additional institutional or transfer courses for a particular subject. 
 

Degree Information 
Degrees sought or awarded can be viewed on the Degree Summary form (SHADGMQ). 
1. Using direct access, enter the form name, SHADGMQ, into the Go field and press <Enter>. 
2. Enter a known social security number or alternate University ID number, or search by name. 
3. Press <Ctrl> + <PageDown> to pull degree information into the form. 
4. Use the scroll bar on the right to view additional degree records. 
Note: An awarded degree is identified by a Status code of ‘AW’.  To view awarded degrees only, 
enter a query using this status code.  See section entitled “Querying Form Data” for further 
assistance with performing queries. 
 

Academic History Reports 
Transcript and graduated student information is available in printable reports and downloadable 
files.  Please see section entitled “Banner Reports” for further information. 
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Querying Form Data 
A query is essentially a question asked of the database, like a name search.  Most Banner forms 
allow the user to enter a query to display data having specified characteristics.  There are three 
basic steps for every Banner query. 
1. To enter a query, click the        [Enter Query] icon on the toolbar or press <F7> on your 

keyboard. 
2. Type the query criteria in the appropriate fields. 
Note: Double-click in any field with a blue text label to obtain a list of values, or consult the Data 

Dictionary in Appendix A to identify appropriate criteria for a field. 
3. To execute the query, click the        [Execute Query] icon on the toolbar or press <F8> on your 

keyboard. 
 
The results of the query will be displayed in the form, and the gray Auto Hint bar at the bottom will 
count the number of records currently displayed.  Only a limited number of records can be 
displayed on the screen at one time, so you may need to use the scroll bar on the right to view 
additional records. 
 
The following example uses the Schedule Section Query Form (SSASECQ) to determine how 
many students were registered in Psychology 100, section 03, for Winter 2003. 
1. Click the Enter Query icon or press <F7>. 
2. Enter the query criteria in the appropriate fields: 

• Term:  200320 
• Subj:  PSY 
• Crse:  100 
• Sec:  03 

3. Click the Execute Query icon or press <F8>. 
 

Using Wild Cards 
 
The % sign can be used as a wild card when performing queries.  The following example uses 
the Schedule Section Query Form (SSASECQ) to determine if any 100-level Business courses 
were offered in Winter 2003. 
1. Click the Enter Query icon or press <F7>. 
2. Enter the query criteria. 

• Term:  200320 
• Subj:  BUS 
• Crse:  1% 

3. Click the Execute Query icon or press <F8>. 
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Using Comparison Operators 
 
By adding greater than and less than symbols (<,>) to your criteria, you can perform more 
complex queries.  The following example uses the Schedule Section Query Form (SSASECQ) to 
determine which sections of ENG 100 for Winter 2003 had fewer than 10 registered students. 
1. Click the Enter Query icon or press <F7>. 
2. Enter the query criteria in the appropriate fields: 

• Term:  200320 
• Subj:  ENG 
• Crse:  100 
• Enroll Act:  <10  

3. Click the Execute Query icon or press <F8>. 
 

Counting Records 
 
The query feature may also be used to return a count of how many records match your criteria.  
The following example uses the Schedule Section Query Form (SSASECQ) to determine how 
many sections of MTH 111 were offered in Winter 2003. 
1. Click the Enter Query icon or press <F7>. 
2. Enter the query criteria in the appropriate fields: 

• Term:  200320 
• Subj:  MTH 
• Crse:  111 

3. From the Query menu at the top of the screen, select Count Hits, or press <Shift> + <F2>.  
Banner will return a record count in the gray Auto Hint bar at the bottom of the screen.  

4. To see the records, click the Execute Query icon or press <F8>. 
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Banner Reports 
Banner reports are generated using Microsoft Access; they cannot be run from within the Banner system.  
Quicknote 36 describes the Banner reports available through Microsoft Access in the ssem2000 
database, how to open the database, and where to locate additional information about using each report.  
All Quicknotes are available online at http://ww2.umflint.edu/its/helpdesk/qnindex.htm. 
 

Course Information 
 
Course Information reports focus on registration and enrollment data for specific course sections.  
See Quicknote 36A for details.  The following Course Information reports are available. 

• Course Rosters  
• Waitlists  
• Missing Grades  
• Grade Verification  
• Department Enrollment  
• Closed Classes  
• Classes Near Capacity  

 

Student Information 
 
Student Information reports are alphabetized lists of student names and addresses based on 
criteria such as major or minority status.  See Quicknote 36B for details.  The following Student 
Information reports are available. 

• Current Students by Major (Address/Phone)  
• Current Students by Major (Detailed)  
• Current Students by Minor (Address/Phone)  
• Minority Students Registered  
• Advising Report by Major  
• Registration Audit Report 

 

Transcript Analysis 
 
The Transcript Analysis is an alphabetic list of courses for a student, including credit hours, 
grade, repeat indicator, term and course attributes.  See Quicknote 36C for details.  The following 
Transcript Analysis reports are available. 

• Check Holds  
• Institutional Transcript Analysis  
• Transfer Transcript Analysis  
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Admission Information 
 
Admission Information reports retrieves an alphabetized list of applicants or admitted students for 
the specified criteria.  See Quicknote 36D for details.  The following Admission Information 
reports are available. 

• All Applicants or Admitted Students for Term 
• Applicants or Admitted Students for a Specific Major and Student Type 
• Applicants or Admitted Students for a Specific Major 
• Applicants or Admitted Students for a Specific Student Type 

 

Graduation Information 
 
Graduation Information reports an alphabetized list of graduate’s name, ID, address, phone 
number, graduation date, and deceased notification based on major and term criteria.  See 
Quicknote 36E for details.  The following Graduation Information reports are available. 

• Graduated Students for Selected MAJOR(s) All Terms  
• Graduated Students for Selected MAJOR(s) Select term  
• Anticipated Graduates for Selected MAJOR(s) and Selected term 
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Student Information Services (SIS) 
 
SIS is a web-based interface that allows faculty and students to access their personal records in the 
Banner system from any computer having an internet connection.  A University ID number (not Banner 
User ID) and PIN are required for SIS login.  Please consult the SIS website, http://www.umflint.edu/sis, 
for further information regarding login and usage. 
 

SIS for Faculty 
 
The following features are available in SIS for faculty with an active appointment. 

• View address 
• View e-mail address 
• View teaching schedule 
• View assigned class list(s) 
• Process registration overrides 
• Submit/view final grades 
• View student information 
• View student class schedule 
• View assigned student transcript 

Note: Course information is available only for courses for which the faculty member is an 
assigned instructor.  Student transcript is available only for students who are currently enrolled in 
an assigned course or are assigned to the faculty member as an advisee (see section entitled 
“Advisor Assignments”). 
 

SIS for Students 
 
The following features are available in SIS for all students. 

• View address 
• View/autoforward e-mail address 
• View UMID 
• View/search course schedule (during registration periods only) 
• Submit registration 
• View class schedule 
• View/pay tuition bill 
• View account detail 
• View holds 
• View grades 
• View transcript 
• View financial aid status 
• View/accept financial aid awards 
• View financial aid payment schedule 
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Help 
 
This User Reference Manual is available in updated format on the ITS website, 
http://ww2.umflint.edu/its/projects/banner.html.  Adobe Acrobat software is required to view the online 
manual. 
 
Auto Hint provides helpful hints and error messages in the gray message bar at the bottom of the Banner 
screen.  The outer window must be maximized in order to view Auto Hint. (see Quicknote 31). 
 
On-line Help from the manufacturer user manuals is available through Dynamic Help Query, found in the 
Help menu.  Use Dynamic Help to search for information about a specific form, block or field.  Be sure the 
Banner button is selected in the help window, then click Display. 
 
Several Quicknotes (listed below) are available to assist Banner users with routine and advanced 
features.  View Quicknotes online at http://ww2.umflint.edu/its/helpdesk/qnindex.htm. 

Quicknote 30 - How to Setup and Login to Internet-Native Banner (INB) 5.x 
Quicknote 31 - Logging in and Changing Your Password in Banner in INB 5.x 
Quicknote 32 - Internet-Native Banner Keystroke Chart 
Quicknote 33 - Conducting Person Searches in Banner 
Quicknote 34 - Creating & Modifying Your Personal Menu in Banner 
Quicknote 36 - Using Banner Reports in Microsoft Access 
Quicknote 36a - Banner Course Information Reports 
Quicknote 36b - Banner Student Information Reports 
Quicknote 36c - Banner Transcript Analysis Reports 
Quicknote 36d - Banner Admission Information Reports 
Quicknote 36e - Banner Graduation Information Reports 
Quicknote 37 - Printing Batch Prerequisite Check Report from Banner 
Quicknote 38 - How to Maintain Advisor Holds and Overrides

  
Complete user manuals from the software manufacturer are accessible from the Banner server, 
N:\User\bdoc6x\bkshlf6x.pdf.  Adobe Acrobat software is required to view the user manual files.   
 
To report Banner problems or to obtain personal assistance, contact the ITS Helpdesk at  
766-6804, or send e-mail to ITSHelpDesk@umflint.edu. 
 
To obtain a Banner ID and password, you must first submit an online Access Request form and then 
complete the self-paced computer-based training.  After your form and CBT score have been received 
your ID will be emailed to you. ID requests may take up to two business days to process.  If you should 
ever need access to additional Banner forms or tables you must complete an Access Change Request 
form.  After approval of the change has been received, access will be granted.  
 
Training Each department/unit on campus is responsible for giving the individual the necessary training 
to do their jobs.  However, the Banner General Navigation training is required for all new users in the form 
of a self-paced computer-based tutorial (CBT). The CBT is the located on Banner drive at 
N:\User\BanNav\setup.exe.  The tutorial is self-paced; it should take you less than an hour to complete.  
Since procedures and standards vary from office to office, each department is responsible for training 
their employees in more specific uses of Banner modules. 
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Banner Data Field Definition Format Oracle Data Field Banner Form 
Academic Status Denotes student's academic progress (usually 

determined by GPA) against requirements for 
continued enrollment in that college/school. 

00 = No Status Available 
AC = Academic Status under Review 
AD = Academic Dismissal 
AP = Academic Probation 
FS = Flint Scholar 
GD = Good Standing 
UO = Up or Out 
WT = Warning on Transcript 

SGBSTDN_ASTD_CODE_END_ 
OF_TERM 

SGASTDN 

Address Line 1 First line of street address  SPRADDR_STREET_LINE1 SPAIDEN 
Address Line 2 Second line of street address    SPRADDR_STREET_LINE2 SPAIDEN
Address Type  A1 = Primary 

BI = Billing 
BU = Business 
CA = Campus 
ER = Emergency 
PA = Parent 

SPRADDR_ATYP_CODE  SPAIDEN

Admit Term Term admitted to University or specific 
school/college. 

See Term for valid codes SGBSTDN_TERM_CODE_ADMIT SGASTDN 

Admit Type  CH = Challenge 
CM = Change of Instructional Mode 
CO = Contract/Conditional 
IT = Intracampus Transfer 
PR = Provisional/Probationary 
RE = Readmit 
SS = Summer Scholar Study 
ST = Standard 

SGBSTDN_ADMT_CODE  SGASTDN

Advisor Code Type of Advisor ADVI = Advising Center 
HONR = Honors Advisor 
INDP = Independent Study Advisor 
MAJR = Major Advisor 
MENT = Mentor Advisor 
MINR = Minor Advisor 
PARA = Paraprofessional Advisor 
PEER = Peer Advisor 
THES = Thesis Advisor 

SGRADVR_ADVR_CODE  SGAADVR

Campus  1 = Main 
2 = Off-campus 
A = Ann Arbor 
D = Dearborn 
N = NetPlus! 

  SGASTDN

City     SPRADDR_CITY SPAIDEN
Class Class Standing based on credits completed FR = Freshman (0-24.99 credits) 

SO = Sophomore (25-54.99 credits) 
JR = Junior (55-84.99 credits) 
SR = Senior (85+ credits) 
GR = Graduate (post-baccalaureate work) 

  SGASTDN

College Individual college or school which grants the 00 = No College Designated SGBSTDN_COLL_CODE_1 SGASTDN 
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degree and directs the program curriculum. AS = College of Arts & Sciences 
EH = School of Education and Human Svcs. 
HP = School of Health Professions & Studies MG = 
School of Management 
RK = Rackham School of Graduate Studies 

Confidentiality Indicator Indicates if person's information is considered 
confidential/unlisted. 

Y = Confidential   

County  See Banner List of Values for code references. SPRADDR_CNTY_CODE  SPAIDEN
Course Three digit number associated with Subject to 

identify course. 
Generally 100-899; see Banner List of Values for code 
references. 
 

SSBSECT_CRSE_NUMB  SFASLST

Course Reference 
Number (CRN) 

Uniquely identifies course sections for a 
specific term. 

Use SSASECQ to look up CRN for given term. 
 

SSBSECT_CRNT  SFASLST

Course Status (see  
Registration Status) 

Identifies the course enrollment status    SFRSTCR_RSTS_CODE SFAREGS

Current Name Full name First Middle Last name SPRIDEN_CURR_NAME  
Deceased Indicator Indicators if individual is deceased. Y = Deceased   
Deceased Date Date of death, if known.    
Degree Program title conferred to student upon 

completion of graduation requirements. 
See Banner List of Values for code references. SGBSTDN_DEGC_CODE_1 SGASTDN 

Degree Status Status of students degree, for example sought, 
awarded, etc. 

AW = Awarded 
PN = Pending 
SO = Sought 

SHRDGMR_DEGS_CODE  SHADEGR,
SHADGMQ 

Department 1 Department for Major 1 See Banner List of Values for code references. SGBSTDN_DEPT_CODE SGASTDN 
Department 2 Department for Major 2 See Banner List of Values for code references.  SGASTDN 
Email Type of Electronic Mail Address BU = Business 

CA = Campus (Official University Email) 
HM = Home 
UNIQ = student’s uniqname 

GOREMAL_EMAL_CODE  GOAEMAL

Enrolled Indicator Do Not Use    
Enrollment Status Status of student's enrollment for specified term. AC = Admin. Drop With Charges 

AN = Admin. Drop No Charges 
CN = Enrollment Cancelled 
EL = Eligible to Register 
W1 = Withdrawn NetPlus! Refund 
W2 = Withdrawn NetPlus! No Refund 
WA = Withdrawn After 2 Weeks 
WB = Withdrawn Before 2 Weeks Refund 
WN = Withdrawn NetPlus! No Refund 
WR = Withdrawn NetPlus! Refund 

  

Ethnicity  1 = African American/Black 
2 = Asian or Pacific Islander 
3 = Native American 
4 = Hispanic/Latino 
5 = White 
7 = Multi Racial / Multi Ethnic 
9 = No Indication 

SPBPERS_ETHN_CODE  SPAPERS

First Name   PERS_FIRST_NAME SPAIDEN 
Full/Part-Time Indicator Full-time or Part-time status based on number F = Full time SGBSTDN_FULL_PART_IND SGASTDN 
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of credits registered for term P = Part time 

Gender     Male
Female 
Unknown 

SPBPERS_SEX SPAPERS

Grade/Final Grade Grade assigned to student for specified course; 
determines honor points awarded 

See Banner List of Values for Grade Codes SHRGRDE_CODE SFASLST, 
Various Others 

Grade Mode Indicates how course will be graded 0 = Standard (ABCDE) 
1 = (ABCDD->N) 
2 = (ABCD>N) 
4 = (ABCC->N) 
5 = (ABC>N) 
A = Audit 
C = Conversion 
M = Mott/UM-Flint Consortium 
P = Pass/Fail 
T = Transfer 

SFRSTCR_GMOD_CODE  SFAREGS,
Various Others 

Graduation Status  GR = Graduated 
IN = Will not graduate, Inactive 
NO = Will not graduate, per student 
PG = Plans to graduate 

SHRDGMR_GRST_CODE  SHADEGR,
SHADGMQ 

Graduation Term Actual or anticipated graduation term See Term for valid codes SGBSTDN_TERM_CODE_GRAD SGASTDN 
ID Identification Number of a person or 

organization. 
Use SOAIDEN to look up valid ID for a given name. SPRIDEN_ID SPAIDEN 

Instructor Faculty member assigned to course.  SPRNAME_NAME SFASLST 
Last Name   PERS_LAST_NAME SPAIDEN 
Level Level is used to denote which degree transcript 

a course should be applied to; Degrees sought 
during different attendance periods are recorded 
on separate transcripts. 

00 = Undeclared 
UG = Undergraduate 
U2 = Second Degree 
U3 = Third Degree 
GR = Graduate 
UT = Physical Therapy, Undergraduate 
PT = Physical Therapy, Graduate 

SGBSTDN_LEVEL_CODE  SGASTDN

Major 1 Primary Major See Banner List of Values for code references. SGBSTDN_MAJR_CODE_1 SGASTDN 
Major 2 Second Major See Banner List of Values for code references. SGBSTDN_MAJR_CODE_1_2 SGASTDN 
Middle Name   SPBPERS_MI SPAIDEN 
Minor 1 Minor for Major 1 See Banner List of Values for code references. SGBSTDN_MAJR_CODE_MINR_1 SGASTDN 
Minor 2 Minor for Major 2 See Banner List of Values for code references. SGBSTDN_MAJR_CODE_MINR_1_2 SGASTDN 
Override Codes Permit Override Codes for Registration ALL = Override All Restrictions 

CAP = Capacity (Waitlist) Override 
DUP = Duplicate Section Override 
PREREQ= Prerequisite Override 

SFRSRPO_ROVR_CODE SFASRPO 

Part of Term  1 = Full Term 
N1 = NetPlus! Year One 
N2 = NetPlus! Year Two 

SFRSTCR_PTRM_CODE  SFAREGS,
Various Others 

Phone area code   PHONE_AREA SPAIDEN 
Phone Extension   PHONE_EXT SPAIDEN 
Phone Number   PHONE_NUMBER SPAIDEN 
Phone Type Associates phone number with appropriate 

address 
A1 = Primary 
BI = Billing 

TELE_CODE  SPAIDEN

 35 



Internet-Native Banner 6x User Reference Manual  

BU = Business 
CA = Campus 
CELL = Cellular Phone 
ER = Emergency 
FAX = Fax 
PA = Parents 

Preferred Name Preferred first name, such as nickname  PERS_PREF_FNAME SPAIDEN 
Primary Advisor 
Indicator 

Indicates primary advisor; only one advisor per 
student may be designated primary 

Y = Primary Advisor SGRADVR_PRIM_IND SGAADVR 

Program Program of Study See Banner List of Values for code references. SGBSTDN_PROGRAM_1 SGASTDN 
Rate Tuition rate See Banner List of Values for code references SGBSTDN_RATE_CODE SGASTDN 
Registered Indicator Indicates that student is registered 

(RSTS_CODE = RE) for at least one course for 
specified term. 

Y = Registered   

Registration Status Describes student's registration status for 
specified course; determines whether 
registration is counted in enrollment for official 
term reports and may also determine fees for 
course. 

AC = Administrative Drop, With Charges 
AN = Administrative Drop, No Charge 
CC = Course Cancelled 
CN = Enrollment Cancelled 
DC = Drop Course, No Charge 
DD = Drop/Delete 
DR = Drop Course, With Charge 
DW = Web Dropped 
RE = Registered 
RW = Web Registered 
W1 = Withdrawn NetPlus! Refund 
W2 = Withdrawn NetPlus! No Refund 
WA = Withdrawn After 2 Weeks 
WB = Withdrawn Before 2 Weeks 
WL = Waitlisted 
WN = Withdrawn NetPlus! No Refund 
WR = Withdrawn NetPlus! Refund 

SFRSTCR_RSTS_CODE  SFASLST,
SFAREGS 

Residence Resident of the state of Michigan 0 = Undeclared 
N = Non-Resident 
R = Resident 

SGBSTDN_RESD_CODE  SGASTDN

Section Course Section Number  SSBSECT_SEQ_NUMB SFASLST 
SSN      Social Security Number 000000000 SPBPERS_SSN SPAPERS
State   Two-letter abbreviation for state, territory, or 

Canadian province. 
SPRADDR_STAT_CODE SPAIDEN

Student Status Active status is eligible to register.  Once a 
student is admitted, they automatically receive 
Active status.  If a student has not registered in 
a period of one year, they receive an Inactive 
status for the current term. 

AS = Active 
IS = Inactive 
GD = Graduated 

SGBSTDN_STST_CODE  SGASTDN

Student Type Describes student's status as a new or 
continuing student; used to track groups for 
IPEDS reporting. 

0 = Undeclared 
C = Continuing 
D = Dual Enrollee 
F = First Time in College 
G = Guest 
N = New Graduate 
P = Professional 

SGBSTDN_STYP_CODE  SGASTDN
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S = Non-Candidate for Degree 
T = Transfer 

Subject Three-letter subject code, such as BIO, HIS, 
ENG, etc. 

See Banner List of Values for code references. SSBSECT_SUBJ_CODE SFASLST 

Term  4 digit year + 2 digit term. 
199910 = Fall 1998 
199920 = Winter 1999 
199930 = Spring 1999 
199940 = Summer 1999 
200010 = Fall 1999 

STVTERM_TERM_CODE  SGASTDN,
Various Others 

Zip Code 5 or 9 digit zip code  SPRADDR_ZIP SPAIDEN 
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Glossary 
 
Block - A section of related information within a form. 
 
Field - The areas in a form where you can enter, query, or change information and where existing 

information is displayed. 
 
Form - Adapted from the traditional, paper-based forms, a Banner form is a screen that allows the user to 

interactively enter and look up related information in the Banner database.  These types of forms 
include: 
• Application: enter, update or query information. 
• Validation: define specific values for certain fields, such as term code, state code, etc.  
• Rule/control: define the rules that impact processing on other forms, such as tuition calculation. 
• Query/inquiry: look up existing information, usually for the purpose of bringing information back to 

the calling form. 
 
Key Block - The first block in each form which contains the required fields for further use of the form. 
 
List of Value (LOV) - Displays a list of values for the current field. 
 
Menu - A list of related forms and/or submenus. 
 
Modules - Each system is comprised of several modules representing business processes of the 

University.  These modules can be viewed in Banner by expanding the menu for each system.   
 
Query - Used to search for occurrences of a particular value or type of data within a form. 
 
Rollback - Clears the form and returns the cursor to the key block. 
 
Systems - The Banner systems currently in production at UM-Flint are: 

• Student 
• Financial Aid 
• General 

 
Wildcards - Symbols used to represent one or more missing characters.  The two wildcards symbols are 
the percent sign (%) and the underscore (_).  The % represents one or more character positions, 
whereas, _ represents exactly one character position.  Each wildcard can be used multiple times within a 
word.  The following example demonstrates use of wildcards to search for the name “Jon McClennan,” 
which could have many spellings. 

• Ex. 1: mcclennan, jo% would obtain people whose first name begins with ‘jo’ and whose last 
name is ‘mcclennan (John, Jon, Jonathan, etc.) 

• Ex. 2: m%n, john would obtain people whose first name is ‘john’ and whose last name begins with 
‘m’ and ends with ‘n’ (MacLennon, McClennan, McMahan, etc.) 

• Ex. 3: mclenn_n, john would obtain people whose first name is ‘john’ and whose last name begins 
with ‘mclenn’ and has exactly one character missing before ending in ‘n’ (McClennan, 
McClennen, McClennon, etc.) 

• Ex. 4: m%len_n, jo% combines all of the above examples 
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